
When working on projects that involve GIS, we often need to share data among organizations that use 

different GIS applications (ArcGIS vs. QGIS vs. MapInfo) or, for example, that use a GIS application made by 

one company, a GPS application made by another company, and a geoprocessing model that was developed 

in-house with Python. To do so, we rely on interoperability. 

Interoperability is a mindset that allows data to be exchanged easily; that prevents the loss or 

corruption of data during exchange; and minimizes the cost of handling data exchanges.  Technologically 

speaking, interoperability is made possible by adopting standards.  Culturally speaking, interoperability is 

made possible by understanding our clients’ and customers’ needs and helping them to reach their goals.   

Required reading: Bolstad (2016: p619-624) 

The Burd Run Stream Channel, Riparian Zone, and Wetlands Restoration Project (Jaymes and 

Woltemade, 2000) restored all those things on the 21-acre “Hornbaker Wetland” property next to campus 

(Britton Rd @ Folgersonger Rd).  Since restoration, the Hornbaker Wetland has been undergoing natural 

change.  The site is now used to provide SHIP students with opportunities for field training related to 

hydrology, geology, biology, and geographic data collection; and for using the data accumulated over the last 

20 years to support student-faculty research.  A recurring need exists to collect new digital snapshots of this 

evolving wetland and to document progress and change since restoration. 

Research question: What are the current site and situation characteristics of the Hornbaker Wetland? 

Georeferenced aerial photography is commonly used to capture before and after conditions at 

disaster, stream restoration, dam removal, or brownfield sites. High-resolution aerial photography is easy to 

interpret and provides analysts with the raw data needed to scout future fieldwork, digitize vector features 

that represent important entities, or evaluate landscape change over time. 

Until recently, collecting aerial photography was a relatively expensive process because it required 

planning a flight mission that will achieve the desired coverage and image resolution, putting a plane into the 

sky, and, if the site footprint is small (like 21 acres small), waiting until you had enough small footprints to 

make a full day of work for the pilot.  That’s largely why past airphotos of the Hornbaker Wetland have been 

collected episodically.   

We’re going to use three different geotechnologies to help us answer our research question, and we need 

these technologies to interoperate. 

 

1. Unmanned Aircraft System (UAS) 

A UAS (a.k.a. “drone”) is a class of geotechnology that can be used to acquire aerial imagery quickly 

and cost effectively. Small UAS can overcome the scale gap between collecting data in the field 

manually and collecting air-borne data in bulk with planes or satellites (Meyers, 2014; Jordan, 2015; 

Kelleher et al., 2018).  In this lab, we are going to learn how to plan a UAS mission for collecting vertical 

aerial photography AND we’re going to deploy a small drone to collect images over the Hornbaker 

Wetland.   



2. Global Navigation Satellite Systems (GNSS) 

A GNSS is a class of geotechnology that is useful for measuring time, location, and elevation; for 

recording attributes; and for assisting navigation and tracking. In this lab, we are going to use GNSS in 

three ways: (1) to geotag photographs taken in the field using mobile device cameras; (2) to conduct 

coordinate surveys of ground control points using a differential grade GNSS device; and (3) to auto-

navigate a small UAS during flight. 

 

3. ArcGIS Online (AGOL) 

As you learned earlier this semester, AGOL is a nifty cloud-based mapping tool.  It allows people and 

organizations to collaborate and to share geographic information, geoprocessing services, and media 

within the familiar browser environment.  In this lab, we’re going to use AGOL to build a map 

application that highlights the Hornbaker Watershed.   

 

 

GNSS devices come in one of three grades: recreational, differential, and survey: 

1. Recreational devices (e.g., mobile phones and pocket receivers) are typically small hand-held 

computers that can be used for place finding, waypoint marking, and geotagging media; under the 

very best conditions, they can make repeated horizontal coordinate measures with ±5 meters of 

precision.   

2. Differential grade devices have larger antennas, better hardware, and better software than 

recreational devices. When coupled with data-cleaning techniques during post-processing, differential 

grade devices can deliver repeated horizontal coordinate measures with sub-meter precision.   

3. Survey grade devices are the state-of-the-art and tend to be very expensive.  They can make repeated 

horizontal coordinate measures with ±1 centimeter of precision in real time.  

 

In the office, we are going to: 

1. plan a UAS mission for collecting vertical aerial photography over the AOI; 

a. perform GNSS mission planning to identify the blocks of time when GNSS satellite-receiver 

geometries are optimal for measuring coordinates; 

b. monitor the local weather forecast to identify the blocks of time when atmospheric conditions 

are suitable for flying a small UAS (clear visibility for 3NM, no precip, wind speed < 12 MPH); 

c. setup an automated flight plan for the small UAS; 

2. prepare a few mobile and GNSS devices for collecting data; 



In the field, we are going to: 

3. layout conspicuous Ground Control Point (GCP) markers in the field; 

4. use a mapping-grade GNSS device to measure the positions of the GCP markers; 

5. deploy a small drone to collect vertical aerial images (with all the GCP markers in place); 

6. take mobile photographs while working in the field; 

Back in the office, we are going to: 

7. post-process the GNSS data collected at the GCP markers; 

8. post-process the aerial imagery collected over the site; 

9. perform an accuracy assessment of the resulting image mosaic – how well do the coordinates of the 

image agree with the coordinates obtained with GNSS? 

and 

10. build an interactive map that allows non-GIS users to interact with the wetland data we collected.   

 

To accomplish our objectives, we need to develop a workflow that assures the data we collect and share are 

accurate, consistent, and complete.  

Planning an aerial mission is an optimization problem.  On the one hand, you want to fly as high as you can to 

capture a lot of ground in each image. The FAA has established a 400 feet AGL ceiling for small UAS, so that’s 

as high as they may go.  One the other hand, you want to fly as low as you can to capture a lot of detail.  The 

tallest tall obstacles on the ground (e.g., trees, buildings, powerlines, etc.) will, however, limit how low you 

can fly safely.  And then there’s fuel (in this case, battery life); you gotta have enough juice to execute the plan 

AND to return home safely.   

 

 
Figure 1. A good flight plan provides you with wall-to-wall coverage and a lot of overlap. This image (Figure 6-

20 in Bolstad, 2017) shows a flight path with about 66% endlap and 20% sidelap. 

Required reading: Bolstad (2016: p247-256, 258-265, 269-271) 



Step 1. Flight planning with DroneDeploy. 

DroneDeploy is an online flight planning and photo processing service that works with a variety of drone 

brands and models.  DroneDeploy charges $300 per month to use its professional services, but they do offer a 

free 14-day / 10-mission trial.  Sign up for a free DroneDeploy account using your Google credentials. 

 

https://www.dronedeploy.com/signup.html 
 

DroneDeploy is fairly intuitive to use.  Missions (including 2 “test” missions) are listed in your table of contents 

on the left.  The map view is on the right.  Feel free to play around with the 2 “test” missions to get a feel for 

how to examine the flight plan properties for each and to make changes to each. 

 

When you’re ready to plan a mission over the Hornbaker Wetland, visit the DroneDeploy’s App Market and 

Install the app called KML and SHP Import.  

 

Next, Plan a Flight Map (+).  If DroneDeploy doesn’t recognize your location, then search for Shippensburg 

University.  DroneDeploy will zoom to the university and create a square-shaped AOI with an initial flight path. 

 

Change the default AOI using the Import KML or ZIP tool.   Submit the Hornbaker shapefile I gave you. 

 

Use the Advanced settings to ensure we get 70% endlap and 70% sidelap. 

 

Adjust the flying Altitude to achieve “1 inch resolution,” which should be high enough to avoid any trees but 

not too high that we forfeit detail unnecessarily. 

 

Next, use the Advanced settings again to change the Flight Direction property.  Rotate the flight path to 

minimize total flight time. 

 

Give your mission a name and save it. 

 

 

Question 1:  Build a table in your report that presents all your flight mission properties. 
 
 

Question 2:  What effect(s) does changing the flying Altitude (+100 ft, -100 ft) have on your mission? 

 

Step 1. Perform GNSS mission planning.  Bolstad (2016: p203-213) 

Anyone who has used a car navigation system or a mobile device knows that your ‘blue dot’ can be plotted 

large or incorrectly on your mobile map.  That’s because most devices are setup to measure positions quickly 

under any satellite constellation rather than to wait until satellite conditions are good enough for measuring 

positions reliably.  GNSS mission planning is the process of predicting when the satellite constellation above 

your work site will be suitable for collecting reliable data.   

 

https://www.dronedeploy.com/signup.html


Use John Deere’s NAVCON’s Satellite Predictor application to plan your GNSS mission and to identify blocks of 

time when satellite-receiver geometries will be optimal above Shippensburg University.   

 

http://satpredictor2.deere.com/lookup 

 

1. Page 1 
a. Choose Your location: Either type in “Shippensburg University” or use the map to choose a 

spot in the AOI.  [Continue] 
2. Page 2 

a. Choose the right Time Zone. If you’re planning field work in Pennsylvania between March and 
November, then you want Eastern Daylight Saving Time (EDT).  If you’re planning fieldwork in 
Pennsylvania between November and March, then you want Eastern Standard Time (EST). 

3. Page 3 
a. Choose the Date we expect to be in the field. 
b. Review the expected satellite Visibility at our designated place and time.  Take notes about 

when 6 or fewer satellites are expected, for those blocks of time could yield less-than optimal 
data.  [Print report] 

c. Review the expected DOPs.  A DOP value works like a golf score – lower numbers are better 

(see Table 1 and Figure 5-12 in Bolstad, 2016: p213).  [Print report] 

 

 

 

Table 1: Meaning of DOP values (H = 2D horizontal, V = vertical, P = 3D positional) 

DOP 
Value 

Rating Description 

< 1 Ideal 
Highest possible confidence level to be used for applications demanding the highest possible 
precision and accuracy at all times. Suitable for in-route navigation. 

1-2 Excellent 
Positional measurements are likely accurate enough to meet all but the most demanding needs.  
Suitable for in-route navigation. 

2-5 Good 
Good enough for making many business decisions. Positional measurements are likely good 
enough to make reliable in-route navigation suggestions to the user.   

5-10 Moderate Approximate results likely.  A more open view of the sky is recommended. Use with skepticism. 

10-20 Fair Positional measurements should be discarded or used only as rough estimates only. 

>20 Poor Garbage in, garbage out. 

 

 

Question 3:  Report any and each ‘good’ block of time (from start time to end time) when the HDOPs and 
VDOPs are expected to be less than or equal to 2.0. This is important because we want to 
avoid doing any GNSS work during bad blocks of time.  Attach copies of your NAVCON reports 
to your lab report. 
 

http://satpredictor2.deere.com/lookup


Steps 2 and 3. Thinking about what needs to be mapped and what needs to be observed. 

Begin a session of GPS Pathfinder Office and setup a New… project named Hornbaker.  Point the 

Project Folder: to your GIS3/labs folder, your T: drive; or the C:\Geotemp folder. 1   

Next, use Trimble’s Utility > Data Dictionary Editor tool to help you prepare for data collection.  

When the tool opens, create a data dictionary called Hornbaker-<your initials>.ddf and save it.   

Set up your data dictionary as follows: 

 

1. Name:  Hornbaker-<your initials> 

2. Comment: September 2018 

3. Version: TerraSync v5.00 and later 

 

4. Create a New point Feature… called GCP with the following settings and symbol: 
a. Default setting 

i. Select a 1-second position logging interval; 
ii. Use a minimum of 90 raw positions to support each GCP; 

b. Symbol 
i. Choose 20-pt benchmark-looking symbol of any color. 

ii. [ OK ] 

c. Next, create New Attributes… 
i. Numeric attribute 

1. Name: GCPID 
2. Comment/Alias: Which GCP? 
3. Decimal places: 0 
4. Minimum: 1 
5. Maximum: 20 
6. Default: 1 
7. On Creation: Normal 
8. On Update: Normal 
9. Auto-Incrementing: 

a. Increment 
b. Step Value: +1 

ii. Menu attribute 
1. Name: Blocked 
2. Alias: Is your horizon blocked? 
3. Menu Attribute Values: 

a. [New…] 
i. Attribute value: Yes 

ii. Default: unchecked 
iii. Code Value 1: 1 
iv. [Add] 
v. Attribute value: No 

vi. Default: checked 
vii. Code Value 1: 0 

                                                             
1 You need to change the default project path because you don’t have permission to write in the IT Administrator folders, 
which were mistakenly set as the default folders during installation. 
 



viii. [Add] 
4. Display in Field As: Radio Buttons  
5. On creation: Required 
6. On update: Normal 

iii. Numeric attribute 
1. Name: PerBlock 
2. Comment/Alias: What percent of your local horizon is blocked? 
3. Decimal places: 0 
4. Minimum: 0 
5. Maximum: 100 
6. Default: 0 
7. On Creation: Normal 
8. On Update: Normal 
9. Condition: [Change] 

a. Enable condition: checked 
b. If this condition is true, “Blocked is No”, then: 

i. On creation: Not Visible 
ii. On Update: Not Visible 

iv. Text field 
1. Name: Comments 
2. Comment/Alias: Open ended comment. 
3. Length: 50 
4. Feature Repeat: Omit from Repeat 
5. On Creation: Normal 

 

Save your data dictionary file and compare your setup against Figure 2.  If everything looks good, then close. 

 

 
Figure 2. Snapshot of a complete data dictionary. 



Next, obtain a Trimble device and insert it into the grey cradle (GeoExplorer 3000 series) or connect it via USB 

(GeoExplorer 6000 series).  Turn on the device (green button).   On your workstation, Microsoft’s Mobile 

Device software should recognize the Trimble device and open a connection.  When prompted, “Connect 

without setting up your device” (we’re not trying to sync music libraries or anything like that, just connect).   

 

Next, open Trimble GPS Pathfinder Office’s Data Transfer utility and connect with the GIS Datalogger on 

Windows Mobile device (if it hasn’t already done so).   

 

Next, add your data dictionary file to your send list, then transfer everything on the send list to the Trimble 

device.  Close and Exit the utility. 

 

Before beginning any fieldwork, make sure you are prepared with suitable clothing, boots, water, and sun 

protection (e.g., a hat, sunscreen).  Expect to be outside and working in a wetland. 

 

When you are in the field and ready to start your survey, start GPS / TerraSync (Professional).  TerraSync is 

data collection software that reads satellite signals and calculates time and position.  It can take several 

minutes to ‘lock’ onto all the satellite signals that are above your local horizon, so be patient. 

 

On start, TerraSync will display its Status window.  Think of yourself as standing at the center and the circle.  

The circumference of the circle represents the 360° local horizon around you.  Each box symbol represents a 

satellite that is in the space dome above your local horizon. 

 

Next, choose the Data option from the pull-down menu, which will let you use your data dictionary 

Hornbaker-XYZ as a template for creating a new data file.  

 

Data file names are auto-generated. The prefix is usually the letter “R” (R for rover); the next two characters 

indicate the month (“03” for March); the next two indicate the day of the month; the next two indicate the 

hour of the day (on a 24-hour clock); and the suffix is usually a letter that auto-increments (from A to Z) during 

the hour. Be sure to choose your data dictionary before you Create your data file. 

 

When prompted, enter the height of the antenna above ground (2.0 m).   

 

Next, if you followed all the directions above correctly, then you should now see 4 buttons: [GCP] and the 

three default feature classes: [Point_generic], [Line_Generic], and [Area_generic]. 

 

Go to the field, collect data, and take pictures.  Bolstad (2016: 227-233) 

 

When you’re finished with all your field work, Close the data file, Menu > Exit TerraSync, and power down 

the device by holding the green power button until the device turns off.  

 

 



Back at the office, turn the device back on and insert it into its cradle (or connect it via USB).  Microsoft’s 

Mobile Device software should open a port for communication.  When prompted, “Connect without setting 

up your device” and minimize the Mobile Device Center window.   

 

Next, start a new session of GPS Pathfinder Office.  Re-open your Hornbaker project. 

 

Next, open the Data Transfer Utility.  Add your data file to your receive list, then transfer all the items on 

the receive list to your project folder.  Close the Data Transfer utility.   

 

 

Question 4:  How did Mission Planning and building a data dictionary change the typical way you do 
fieldwork?   

 

 

All that mission planning you did was to ensure you collected data when optimal conditions were expected.  

Working to plan does not guarantee, however, that field conditions were actually optimal, that you actually 

collected good data, or that your dataset is actually complete.   

Your raw data are likely infected with some errors. Tall buildings or trees may have blocked some of 

the available satellites, thus increasing your DOPs (see Figure 2), or worse, they may have caused a satellite 

signal to bounce before arriving at your device (see Figure 2).  A GNSS receiver cannot distinguish a direct 

signal from a longer multipath signal. See Figure 5-31 in Bolstad (2016, p231). And then there’s human error 

on top of all that.  These errors are just some of the reasons why you never want to give raw data to a client.   

 
 

Figure 2. Actual field conditions can be different than predicted field conditions.  This image shows buildings 

blocking some satellite signals and causing others to bounce indirectly toward a car with SatNav.  The same 

can happen to you near hills or under tree canopies. 

 

Before post-processing, make a copy of your data file (e.g., copyR0*.ssf).  Working with a copy will let you 

practice and play with impunity.  The original *.SSF file will serve as your back-up. 

 

Start another session of GPS Pathfinder Office and re-open your Hornbaker project.  Make sure you can 

see the Map, Time Line, Feature Properties, and Position Properties windows. 



Next, set the Options > Coordinate System… to US State Plane 1983, Pennsylvania South 3702 (NAD83).  

Set your vertical datum to be Mean Sea Level (via the latest available GEOIDxx model).  All coordinate values 

should be displayed in meters. 2     

 

Next, File > Open… your data file (copyR0*.ssf).  If you setup your data dictionary correctly, then you 

should see where your features were measured (Map window) and when they were measured (Time Line 

window).   You can use your cursor to select a feature in either window and the corresponding symbol will 

become selected in the other window.  Notice how the Feature and Position attributes change with selection. 

 

 

Question 5:  How many GCPs did we layout and how many GCP features are in your feature class?   
 

 

Exploring your raw data 

Use your cursor to select a feature.  The Feature Properties window lets you review feature attributes.  

Meanwhile, the Position Properties window reports the average of uncorrected Easting, Northing, and Altitude 

values derived from your raw sample of 150 positions. 

 

Change the View > Layers > Features… > Not in Feature > Symbol… properties so they have a 

dark color and a thick width.   

 

Next, use the Feature Properties window to Delete your selected feature.  Relax, deleting a selected feature 

doesn’t do harm (unless you hit “save”).  Deleting a feature allows you to see the raw sample of single-fix 

positions that support your feature.  Change map scale and pan to focus on your supporting sample.   

 

 

 

Question 6:  How many raw single-fix positions (repeated measures) were used to support the average 
coordinates for your feature? 

 
 

 

Next, use your cursor to select raw positions, one-by-one, and examine their coordinates and DOP values.  Use 

the Position Properties window to see how your measuring method changed over time as satellites entered or 

left the constellation above your local horizon.  Notice how the DOP values can jump. 

 

 

 

Question 7:  Where and when was the best (lowest) PDOP observed?  The worst (highest)?  In each case, 
how many satellite signals were used to measure the position at that moment in time? 

 

 

 

                                                             
2  Remember, all GNSS receivers spatially reference positions to the WGS84 ellipsoid model only.  These settings do not change the 
actual geographic coordinates { λ, Φ, h } that you measured; rather, they simply tell your desktop software which spatial reference 
system you want to use for display purposes only.     



 

Question 8:  Change map scale and look at the entire pool of supporting positions.   
 

a) Does your pool of raw positions have a dense central cluster?  If so, how wide is it?  (Use the 
Measure tool.)   
 

b) How far apart is the most distant pair of raw positions? (Again, use the Measure tool.) 
 

c) Interpret your answers above to characterize how consistently your equipment/method produced 
the same result during repeated measures?  In other words, use the two distances you just 
measured to describe the precision of your measuring method. 

 

 

Return to your Feature Properties window and [Un-delete] your selected feature.   

 

 

Applying differential corrections to your raw data.  Bolstad (2016: p215-220) 

As described in your textbook, differential correction techniques require at least two proximate GNSS devices 

to receive satellite signals simultaneously.  One receiver is installed at a fixed and known point; this receiver is 

called the “base station” (e.g., a National Geodetic Survey CORS site, see Figure 3).   The other receiver is 

mobile and used for fieldwork; this receiver is called the “rover.”   

The “base” is installed at a known spot and it measures its known self over-and-over again.  Any 

observed difference between the measured coordinates (obtained via GNSS) and the already-known 

coordinates (thanks NGS CORS) can be blamed on the atmosphere.    

 

 

𝐷𝑖𝑓𝑓𝑒𝑟𝑒𝑛𝑐𝑒𝑏𝑎𝑠𝑒 @ 𝑡𝑖𝑚𝑒𝑥
= 𝐴𝑐𝑡𝑢𝑎𝑙𝑏𝑎𝑠𝑒 − 𝑀𝑒𝑎𝑠𝑢𝑟𝑒𝑑𝑏𝑎𝑠𝑒 @ 𝑡𝑖𝑚𝑒𝑥

 Eq. 1 

 

 

If we assume that your rover used the same satellites AND suffered the same atmosphere as the base station 

suffered, then any observed “differences” at the base can be used, in turn, to “correct” the data obtained by 

the rover; hence the term differential correction.  Differential corrections are applied to the raw sample of 

single-fix positions, which will subsequently adjust each average feature. 

 

 

𝐶𝑜𝑟𝑟𝑒𝑐𝑡𝑟𝑜𝑣𝑒𝑟 @ 𝑡𝑖𝑚𝑒𝑥
= 𝑅𝑎𝑤𝑟𝑜𝑣𝑒𝑟 @ 𝑡𝑖𝑚𝑒𝑥

− 𝐷𝑖𝑓𝑓𝑒𝑟𝑒𝑛𝑐𝑒𝑏𝑎𝑠𝑒 @ 𝑡𝑖𝑚𝑒𝑥
      Eq. 2 

 

 

Trimble software performs differential correction swiftly.  Speed is great for the professional, but speed 

makes it difficult for students to watch what is happening and learn.  So, follow these directions and you’ll be 

able to watch the process and get a better sense of how differences measured at the nearest CORS are used 

to correct your rover data. 

 



 
 

Figure 3. An illustration of the differential correction system. 

 



1. Open the Utilities > Differential Correction… utility.  You might be prompted to save your file if 
you made any changes: the choice is yours to make. 
 

a. Select the SSF file(s) you wish to correct. 
i. [Next] 

b. Processing type 
i. Automatic Code and Carrier Processing (Recommended) 

ii. Use a single base provider 
iii. [Next] 

c. [Change…] the Correct Settings 
i. Output positions: 

1. Corrected only 
ii. Use new GPS Filtering settings: 

1. Elevation mask = 10° 
2. Minimum Signal-to-Noise ratio = 33 
3. Maximum PDOP = 10 
4. DO re-correct real-time code positions 
5. [OK] 

iii.  [Next] 
d. Base Data 

i. Use Base Provider Search and Select… the closest base station (e.g., CORS, 
MCCONNELLSBURG (PAFM), PENNSYLVANIA).  Choosing this option instructs the 
software to access the CORS server over the Internet and request base station data. 

ii. DO use the position from the downloaded base files. 
iii. DO Confirm base data and base position before processing. 
iv. [NEXT] 

e. Output folder 
i. Use the same folder as the input file 

ii. Create a unique filename … 
iii. [START] 

 

 

Question 9:  How many base files, if any, did the software download for you? 
 

 

Question 10:  How much coverage (amount of temporal overlap, expressed as a percent) exists between 
your rover data and the base station data? 
 

iv. [CONFIRM] 
 

 

Question 11:  Knowing that satellites-receiver geometry can change over time, it is likely that you measured 
some raw positions during better conditions than others.  How many (#) and what share (%) of 
your corrected positions fell into each “range” of uncertainty?   

See Bolstad (2016) Figures 5-11, 5-12, and 5-31 

 

v. [CLOSE] 



 

2. File > Close your uncorrected data file (*.SSF). 

3. File > Open your corrected data file (*.COR). 
 

 

Question 12:  Did you lose any features after differentially correcting your raw positions?  (#, %)? 
 

 

 

Exporting your corrected data 

Follow these directions to export your corrected GCPs to delimited text *.CSV format. 

 

1. Open the Utilities > Export… tool.   
a. Select your corrected (*.COR) data file as input for export. 
b. Choose your output folder (where the outputted CSV file will be saved). 
c. Choose the Sample Configurable ASCII Setup option. 
d. [Properties…] 

i. Data 
1. “Export all Features” 
2. Uncheck “Include Not in Feature Positions” 

ii. Output 
1. “For each input file create output file(s) of the same name.” 
2. System File Format: Windows. 

iii. Attributes (for the output attribute table) 
1. Export menu attributes as Attribute Value 
2. All features (check all of the following) 

a. PDOP 
b. HDOP 
c. Correction status 
d. Receiver type 
e. Date recorded 
f. Time recorded 
g. Data File Name 
h. Total positions 
i. Filtered positions 
j. Data Dictionary Name 

3. Point features (check at least the following) 
a. Vertical Precision 
b. Horizontal precision 

iv. Units 
1. Use Current Display Units 
2. Latitude/Longitude Options: DDD.dddddd  
3. Time format: 24 Hour clock 

v. Position Filter 
1. Position Filter Criteria 

a. Minimum Geometry = 3D (5 or more) 
b. Maximum PDOP = 6 
c. Maximum HDOP = 6 



2. Include positions that are: 
a. Check every option except Uncorrected positions 

vi. Coordinate system 
1. Use Export Coordinate System [Change] 

a. System: Lat/Long 
b. Datum: WGS 1984 
c. Altitude units: Meters 
d. Altitude reference: MSL 

vii. Configurable ASCII 
1. File Options: One Set of Files  per Feature Type 
2. Template List 

a. [Delete] any templates that are there (e.g., pos, att, etc.) 
b. Make a [New…] template called CSV 

i. Output file extension: csv 
ii. Apply to: Points 

iii. Field format: Delimited 
iv. Delimiters 

1. Field: Comma (,) 
2. Text: Double Quotes (“) 
3. Decimal: Dot (.) 

v. Template Worksheet (see Figure 2 below) 
vi. {Feature ID} {Longitude} {Latitude} {MSL} {Attributes} ~ 

[New Line] 
3. [OK] 

e. [OK] 
 

 
 

Figure 4: ASCII Export Template Editor: Your output CSV file template. 

 

[Newline] 



 

Question 13:  How many of your features survived the export filter (see 1.d.v.1 above) and were exported? 
 

 

Close your file and exit GPS Pathfinder Office. 

 

 

You will receive a link to a ZIP archive containing all the aerial photographs we captured.  After extracting 

them from the archive, you’re going to geoprocess them in two ways: 

 

Post-processing aerial photographs in ArcGIS 

If you haven’t already done so, create a geodatabase for this project.  Next, create a set of point features 

representing the centroid of each photograph (see Table 2). 

 

Table 2: Parameters for the GeoTagged Photos To Points tool (Esri 2017a). 

GeoTaggedPhotosToPoints_management(Input_Folder, Output_Feature_Class, {Invalid_Photos_Table}, 

{Include_Non-GeoTagged_Photos}, {Add_Photos_As_Attachments}) 

Parameter Explanation Data Type 

Input_Folder The folder where your photo files are located.  Folder 

Output_Feature_Class The output point feature class. 
Feature 
Class 

Invalid_Photos_Table 
(Optional, in this case, Yes) 

An output table that will list any photo files in the input folder with 
invalid Exif metadata or empty GPS coordinates. 

Table 

Include_Non-GeoTagged_Photos 
(Optional, in this case, ONLY) 

 ALL_PHOTOS — All photo files will be added as records to 
the output feature class. If a photo file does not have GPS 
coordinate information, it will be added as a record with null 
geometry. This is the default. 

 ONLY_GEOTAGGED — Only photo files with valid GPS 
coordinate information will have records in the output 
feature class. 

Boolean 

Add_Photos_As_Attachments 
(Optional, in this case, ADD) 

 ADD_ATTACHMENTS — Photo files will be added to the 
output feature class records as geodatabase attachments. 
Geodatabase attachments are copied internally to the 
geodatabase. This is the default. 

 NO_ATTACHMENTS — Photo files will not be added to the 
output feature class records as geodatabase attachments. 

Boolean 

  

 



Next, sort your airphoto centroids by datetime and recreate the flight path in shapefile format (see Table 3).  

The reason why we’re writing to Esri shapefile format is because we want to ZIP the output for upload and use 

in ArcGIS Online. 

 

Table 3: Parameters for the Management > Points to Line tool (Esri, 2017b). 

PointsToLine_management(Input_Features, Output_Feature_Class, {Line_Field}, {Sort_Field}, 

{Close_Line}) 

Parameter Explanation 
Data 

Type 

Input_Features The point features to be converted into lines. 
Feature 
Layer 

Output_Feature_Class The line feature class which will be created from the input points. 
Feature 
Class 

Line_Field 
(Optional) 

Each feature in the output will be based on unique values in the Line Field. Field 

Sort_Field 
(Optional, in this case sort by 
DateTime) 

By default, points used to create each output line feature will be used in the 
order they are found. If a different order is desired, specify a Sort Field. 

Field 

Close_Line 
(Optional, in this case, NO) 

Specifies whether output line features should be closed. 

 CLOSE —An extra vertex will be added to ensure that every output 
line feature's end point will match up with its start point. Then 
polygons can be generated from the line feature class using 
the Feature To Polygon tool. 

 NO_CLOSE —No extra vertices will be added to close an output 
line feature. This is the default. 

Boolean 

 

Post-processing aerial photographs in DroneDeploy 

Return to DroneDeploy.com and log into your trial account. 

 

Visit Drone Deploy’s App Market again and, this time, Install the app called ArcGIS Online Web Tile Layer.  

You’ll use this app too share your geoprocessing results at DroneDeploy with AGOL.  But first, you need to 

derive a mosaic from the raw input images. 

 

Next, ignore your flight plan and Upload images (+).  Give your mosaic a user friendly name and upload all 

the JPGs we collected. 

 

DroneDeploy will send you an email when your geoprocessing is finished, at which time you can return, review 

your results, and Export the mosaic for download and use in the ArcGIS Desktop environment. 

 

http://desktop.arcgis.com/en/arcmap/10.5/tools/data-management-toolbox/feature-to-polygon.htm


At this point, you should have: 

 One geodatabase containing point features representing aerial photograph centroids. 

 One zipped shapefile of our flight path, which was derived from the points above. 

 One CSV file containing the differentially corrected positions and attributes of our GCPs 

 One folder of raw aerial photographs 

 Two copies of your aerial mosaic: 

  One downloaded and ready for use with ArcGIS for Desktop 

  One available at DroneDeploy.com and ready for sharing with ArcGIS Online. 

Together, we’ll build two simple web maps and one map application in-class to highlight the Hornbaker 

Watershed.  Just make sure you have everything listed above. 

Complete a well-written report of the lab exercise. Include the lab title and your name and date on the 

first page.  Your report should include six sections and headings: Purpose, Objectives, Methods and Data, 

Results and Answers, Summary, and References. Provide a brief introduction with purpose and concise 

objective statements using your own words.  Describe the important methods and input data you used. In the 

Results and Answers section, address any issues or questions prompted during the lab. Include tables and 

figures in the same order you refer to them. In the Summary section, describe how you accomplished the 

purpose of the lab (i.e., how well did you answer the research question); then identify anything that you 

learned, or anything that remains problematic. I encourage you to share your “lightbulb” moments.  Your 

References section should list any resource that you used to borrow facts, figures, or quotes. 

All lab reports should be typed and printed on 8.5” by 11” stock. Before drafting your report, set your 

left and top margins to 1.2” and set the others to 0.7”.   

For the body, set the normal font face to be Candara, Bookman Antiqua, Bookman Old Style, or 

Georgia; never use Times New Roman or any kind of decorative font. Set the normal font size to be 11 points. 

Use 1.5 line spacing. Include page numbers on every page. Major section headings should be in bold face. All 

tables and figures must be inserted into the body of your report and conform to the formatting and margin 

requirements.  Regarding tables: (1) columns containing text should be left justified; (2) columns containing 

numbers should be right justified; (3) values in a column should be presented using the same level of decimal 

precision; and (4) your table records should be sorted meaningfully, especially if the purpose of the table to 

help the reader find highest and lowest values. 

Also, attach the two reports you generated during GNSS Mission Planning as appendices. 
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